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Document Flow Manager
Exploring

Where it fits in?
SYSPRO's Document Flow Manager facilitates collaborative commerce by providing a means of
automating document processing from within or outside the organization. These can be
incoming and outgoing documents, such as sales orders, purchase orders, etc.

When using the Document Flow Manager, you are licensed to use all
business objects via the DFM.

The Document Flow Manager uses two services:

SYSPRO 8 Document Flow Manager Folder Poller

This service monitors specified folders and uses the contract details to determine if the
files in the folders should be sent to the DFM queue.

SYSPRO 8 Document Flow Manager Queue Poller

This service monitors and processes files in the DFM queue.

Terminology
DFM Contract
A contract defines the folders which Document Flow Manager must monitor, the type of
document to look for, what to do with the document once it's located, which business
object to call, and what to do with the response from the business object (e.g. transform the
document using XSLT before and/or after processing by the business object).
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Starting
Prerequisites

You must be licensed to use Document Flow Manager.

Ensure that the same license.xml file that was imported to install DFM under the
core product, is imported for e.net Solutions.

The Document Flow Manager services must be running:

 SYSPRO 8 Document Flow Manager Folder Poller

 SYSPRO 8 Document Flow Manager Queue Poller

These services are installed using the SYSPRO Installer.
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Solving
Error messages
Document Flow Manager Executable error

Synopsis
The DFM services abort with messages indicating that the Document Flow Manager
executable encountered a problem and needs to close.

Cause
This is typically as a result of the SYSPRO 8 Document Flow Manager Folder Poller or
SYSPRO 8 Document Flow Manager Queue Poller services starting before the SQL service
has finished loading.

In a SQL server environment the SQL service must be running before the Document Flow
Manager services are started.

Solution
You need to add MSSQL to the DependOnService list in the registry for all DFM services.
This will force the SQL service to finish loading before the Document Flow Manager services
start.

1. Open the Registry Editor (Start > Run).

2. Navigate to the folder containing the local machine system services (HKEY_LOCAL_
MACHINE > SYSTEM > CurrentControlSet > Services).

3. Locate the DFM service and add a new Multi-String Value to the data pane.

a. Right-click the pane and select New.

b. Enter DependOnService at the Value name field.

c. Right-click the DependOnService entry and select Modify.

d. Enter MSSQLat the Value data field.

e. Select OK.

4. Exit the Registry Editor.
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Warning messages
Spurious failures during document processing

Synopsis
Although Document Flow Manager doesn't typically try to retrieve a file until processing is
complete, it can happen that an incomplete file is retrieved and an attempt is made to
process the file.

Usually, even if you placed a large file in a folder that is being polled, Document Flow
Manager won't try to retrieve the file because the operating system retains a lock on the file
until the writing process is finished.

However, if a large file is transmitted to a folder that is being polled using infrared (e.g. in a
demonstration environment) it is possible that the first part of the file is retrieved and an
attempt is made to process it before the document is completely written to the folder.

Cause
This occurs because infrared writes the file in pieces and the lock is removed from the file
after writing each piece. The lock is reapplied when the next part of the document arrives. If
the folder is polled during the time that the lock is released (but before the file is complete)
then the file is retrieved and an attempt is made to process it.

Similarly, it is possible that a file which is being written to by a third-party application
incrementally, is retrieved in a partial state if the lock is released by the application. An
attempt will be made to process this partial document.

Solution
We recommend that you build the file in a folder that is not being polled by Document Flow
Manager and then move the completed file to the polled folder.
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FAQs
General
Why do XML documents need to be transformed?
Incoming and outgoing files that aren't in the required format must be transformed
using XSLT.

You can define the transformation detail at the Transform XML document section of
the DFM Setup program.

You can specify the XSLT file that must be used to transform the file before it passes to
the business object.

You can also specify that the outgoing file from the business object must be transformed
before it is saved to the Outgoing folder.

DFM Services
Where should the DFM folder poller service be installed?
The SYSPRO 8 Document Flow Manager Folder Poller service can be installed on any
server(s) and/or machine(s).

The service communicates to the queues using the SYSPRO 8 e.net Communications
Load Balancer service and business objects. Therefore, installing on various machines
reduces the load on the SYSPRO application server.

In earlier versions (e.g. SYSPRO 7 Update 1) this service could only be installed on the
SYSPRO Application server.

Why should I install multiple DFM folder poller services?
Installing multiple SYSPRO 8 Document Flow Manager Folder Poller services lets you
spread the load over multiple servers, ensuring that the polling of folders runs more
efficiently.

In earlier versions (e.g. SYSPRO 7 Update 1) you could only install one DFM poller service.

Where can I set the polling type for DFM services?
Although the following flags can't be maintained in the DFM Service Setup program, you
can edit them in the SYSPRODFMQueuePoller.exe.config and
SYSPRODFMFolderPoller.exe.config configuration files:

ZeroFileSizeDeleteTime

ConfigPollType (defaults to ss - seconds)
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FolderPollType (defaults to ss - seconds)

PollType (defaults to ss - seconds)

This will be addressed in a future release.

Why don't the DFM Services start?
The password held against the operator used to start the services may have changed.
This could occur automatically by the operating system, depending on the password
policy setup.

Solution

Review the password settings defined against the operator who is starting the
services.

Review the message logs within the Event Viewer.

Why don't the DFM Services start on installation?
This is most likely due to an invalid operator/password combination or the operator
doesn't have sufficient permission to access the folder contents.

Solution
Review the message logs within the Event Viewer.

How do I add SQL Server as a dependency for DFM services
The following steps describe how to add SQL Server as a dependency for the SYSPRO 8
Document Flow Manager Folder Poller and SYSPRO 8 Document Flow Manager
Queue Poller services.

This will force SQL Server to finish loading before the services start.

1. Open the Registry Editor (Start > Run).

2. Navigate to the folder containing the local machine system services (HKEY_LOCAL_
MACHINE > SYSTEM > CurrentControlSet > Services).

3. Locate the DFM service and add a new Multi-String Value to the data pane.

a. Right-click the pane and select New.

b. Enter DependOnService at the Value name field.

c. Right-click the DependOnService entry and select Modify.

d. Enter MSSQLat the Value data field.
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e. Select OK.

4. Exit the Registry Editor.

Where do I define the 'file size delete time' for the DFM folder
poller service?
Although you can't currently maintain the FileSizeDeleteTime in the DFM Service
Setup program, you can edit this in the following configuration files:

SYSPRODFMQueuePoller.exe.config

SYSPRODFMFolderPoller.exe.config

Configuration
Why are the changes I made not implemented immediately?
Any configuration changes made using the DFM Service Setup program only takes effect
when next the service polls for a change in configuration information.

This interval can be specified at the Config Interval column of the DFM Service Setup
program.

How do I configure the processing of XML documents?
You can configure how SYSPRO processes incoming, outgoing and failed XML files using
the XML Document Control program (Program List > Business-to-Business Trading.

The following configuration can be defined:

Queue type for which you want to keep history.

Number of days you want to retain historic documents.

Number of days you want to retain failed documents (actioned and unactioned).

History path for all documents.

Destination paths where historic customer and supplier documents are stored.

Destination path of failed documents.

Problem Solving
Where can I find the DFM event log?
The event log is created when DFM is installed. The log is output to the following folder,
which you can review for diagnosing any problems you may encounter:

Control Panel > System and Security Administrative Tools > Event Viewer > Applications and
Service Logs

You can open each entry in the log to view the error or warning details.
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The event log is only available if you have selected Yes at the Log required option in the
list view of the DFM Service Setup program.

Why do documents remain in the polling folder?
Likely causes are that the document is not being picked up at all, or is being picked up
but the Document Flow Manager user doesn't have permission to delete the original
document from the folder.

If the document is not being processed, then there are a number of possible causes:

The contract is configured to poll a different folder.

Check the relative pathing from which the service is run.

If the folder is on a remote workstation, ensure that the machine is running and
that the SYSPRO application server can see both the machine and the
share/mapped drive.

The file does not match the file type defined against the contract.

The contract is disabled.

The SYSPRO 8 Document Flow Manager Folder Poller service doesn't have
permission to access the folder.

The file is defined as read-only.

Review the attributes against the file.

The SYSPRO 8 Document Flow Manager Folder Poller service is not running.

Why are there no results for documents in the polling folder?
The SYSPRO 8 Document Flow Manager Queue Poller service is not running, or the
contract is not configured to output the results from the business object.

Solution

Review the contract to ensure that it is configured to output the results from the
business object and that the correct folder is specified.

Check that the operating system user who is starting the SYSPRO 8 e.net
Communications Load Balancer service has been granted write-access to the
folder.

Check that the user for the SYSPRO 8 e.net Communications Load Balancer
service has been granted write-access to the Failed folder.

Why is the Security tab missing from the folder properties?
This typically occurs on demonstration machines and prevents you from setting folder
access permissions.
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Solution

Ensure that your operating system is supported by e.net Solutions and Document
Flow Manager.

Review the file system type being used by the operating system.

FAT or FAT32 file systems don't allow you to set folder permissions, which could
explain why the Security tab isn't visible.

Although you can change the file system type using the convert command line
utility, this should only be done after considering the effects on other applications
already running on this machine.

Why are 3 error messages written to the 'Failed' folder for every
failed process?
Error message files are written to the Failed folder in triplicate for you establish where
the error occurred.

The message file names are the same, except for the last character (e.g. 00000008e.xml,
00000008s.xml or 00000008t.xml):

Files ending in e contain the error message.

Files ending in s contain the original incoming document.

Files ending in t contain the details after transformation.

This allows you to view the actual error message and compare the original incoming
document to the transformed document.
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DFM Setup
Exploring

Where it fits in?
This program lets you add, configure and delete contracts for the Document Flow Manager.

Things you can do in this program include:

Add new contracts.

Maintain and delete existing contracts.

Disable contracts.

Disable all contracts for a company.

Configure SMTP settings for email notifications.

Navigation
This program is accessed from the Program List pane of the SYSPRO menu:

Program List > Administration > Document Flow Manager
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Starting
Prerequisites

The Document Flow Manager services must be running:

 SYSPRO 8 Document Flow Manager Folder Poller

 SYSPRO 8 Document Flow Manager Queue Poller

These services are installed using the SYSPRO Installer.

Other considerations
Licensing

Ensure that e.net Solutions licensing has been configured for your SYSPRO
installation.

This can be established using the Configure e.net License function from within
the System Setup program.

If you are licensed to use e.net Solutions then a window is dis-
played enabling you to apportion licenses to the required oper-
ators. Otherwise you will be required to import the
license.xml file.

Ensure that your SYSPRO installation is licensed to use e.net System Manager and
the Document Flow Manager

Document Flow Manager is typically licensed by the number of concurrent
SYSPRO users.

The license includes DFM access to any business object. If you're only going to use
business objects from DFM, then you only need to license the e.net System
Manager and Document Flow Manager).

This doesn't mean that you can merely license the e.net System
Manager and Document Flow Manager and access all the
business objects from your own custom development, or from
the Web-based Applications. These would still need to be
licensed in the normal way.
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Encoding considerations

Under MSXML 3.0, the default encoding message written out to a new XML file is
UTF-16 even if the file is in UTF-8 format.

Although it doesn't appear possible to write out a UTF-8 encoding message, you
can prevent an encoding message from being written out by changing the
xsl:output8 section to include omit-xml-declaration="yes" in your XSL file.

FOR EXAMPLE:

If you already had the entry:
&lt;xsl:output method="xml"

encoding="UTF-8" version="1.0" indent="yes" /&gt;

then you could resolve the problem by changing it to:
&lt;xsl:output method="xml" omit-xml-declaration="yes"

encoding="UTF-8" version="1.0" indent="yes" /&gt;

Restrictions and Limits
If the Document Flow Manager is required to poll a folder on another machine on
the network (not a mapped drive environment) then the DFM services user must have
permission to access that folder (i.e. read and write).

Although Document Flow Manager can process contracts for any company id
(regardless of the company used to create the service) a contract created within one
SYSPRO company is, however, specific to that company. All companies with active
contracts must be licensed to use the DFM. If you have more than one SYSPRO
company and is licensed to use Document Flow Manager, you must import the
license.xml file for each company.
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Solving
Warning messages

You are about to disable a company

Synopsis
This warning message is displayed if you selected the Company disabled option from
the DFM Setup program toolbar.

Solution
You can disable all contracts for the selected company by clicking OK or keep the
contracts enabled by clicking Cancel.

FAQs
Configuration
How do I configure the processing of XML documents?
You can configure how SYSPRO processes incoming, outgoing and failed XML files using
the XML Document Control program (Program List > Business-to-Business Trading.

The following configuration can be defined:

Queue type for which you want to keep history.

Number of days you want to retain historic documents.

Number of days you want to retain failed documents (actioned and unactioned).

History path for all documents.

Destination paths where historic customer and supplier documents are stored.

Destination path of failed documents.
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General
Why do XML documents need to be transformed?
Incoming and outgoing files that aren't in the required format must be transformed
using XSLT.

You can define the transformation detail at the Transform XML document section of
the DFM Setup program.

You can specify the XSLT file that must be used to transform the file before it passes to
the business object.

You can also specify that the outgoing file from the business object must be transformed
before it is saved to the Outgoing folder.

How do I query XML documents?

1. Open the the XML Document Control program.

2. Select the type of document, operator and date range for which you want to conduct a
search.

3. Select Start Processing to start the search process.

Depending on your selections, a list of documents is displayed in the list view.
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Using
Hints and Tips

Create the DFM folder structure before adding new contracts.

Columns in a list view are sometimes hidden by default. You can reinstate them using
the Field Chooser option from the context-sensitive menu (displayed by right-clicking
a header column header in the list view). Select and drag the required column onto
the list view.

Press CTRL+F1 within a list view or form to view a complete list of functions available.
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Referencing
Menu and Toolbar
Field Description

File

Exit This exits the program.

Edit

Add This adds a new data record.

The Add New Contract wizard is displayed and takes you
through the steps to create a new contract.

Change This lets you change details for the highlighted data record.

Delete This deletes the data record currently displayed.

View

SMTP Options Setup This configures the SYSPRO settings required for Document Flow
Manager.

Display

Structured view Select this to view a list of contracts in a treeview style.

The list is sorted by:

Company

Business object class

Method name

Invoked business object

Flat view Select this to view a list of contracts in a list view style.

Refresh view This refreshes the list of contracts in the Documents pane.

Company disabled This disables the DFM functionality for the company, which
stops all DFM transactions from being processed.
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Documents
Column Description

Documents This indicates the document name.

In Structured view mode, the company, business object class,
method name and invoked business object is also displayed.

Program This indicates the business object that is invoked.

Enable/Disable contracts This lets you enable or disable a contract.

Contract disabled This indicates whether the contract is disabled.

Company disabled This indicates whether the company is disabled.

When a company is enabled or disabled, all
contracts for that company are automatically
enabled or disabled.

Operator This displays the operator code of the operator saved against the
DFM contract.

Folder to poll This displays the folder that is polled for documents.
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Document Flow Manager Control Setup
This is displayed when you select the SMTP Options Setup from the View menu.

Fields in the wizard may be pre-populated depending on the e.net business object class.

Field Description

User company settings Tick the User company SMTP details field if you want to enforce
the company SMTP details.

SMTP server IP address Enter the IP address of the SMTP server from which you want to
forward outgoing email.

This only applies if you selected to send response emails on the
contract.

Default Email address This is the default email address to which messages are sent.

This email address is used when a contract stipulates that an
email should be sent, but no email address has been specified
on the contract.

This address is used if emails are being sent from an SMTP
server. Alternatively, you can use this address to identify the
smart host through which all outgoing messages for remote
domains must be routed (instead of sending them directly to the
domain).

This allows messages to be routed over a connection that may
be more direct or less costly than other routes.

Enclose the IP address in brackets [ ] to increase system
performance. The brackets identify the value as an IP address
and because Microsoft SMTP service checks for a name before
checking for an IP address, the DNS look-up is bypassed.

The smart host is similar to the route domain option for remote
domains. The difference is that once a smart host is designated,
all outgoing messages are routed to that server. With a route
domain, only messages for the remote domain are routed to a
specific server. If a smart host has been configured, then you can
still designate a different route for a remote domain. The route
domain setting overrides the smart host setting.

Username Enter the domain username (used to authenticate the SMTP
server).

Password Enter the password for the domain username.

Server port Enter the SMTP server port.
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Add New Contract Wizard
This wizard is launched when you select to add a new contract and helps you create a new
contract between a document type and the Document Flow Manager.

The contract is saved in the DfmQueueDetail table with a unique QueueID.

Field Description

Contract details

Contract name Enter the contract name that will be used to identify the contract.

Business Object class Indicate the type of business object that is used for this contract.

Build

Adds a business object to the contract that is used to build
entities.

Query

Adds a business object to the contract that is used to perform
queries.

Setup

Adds a business object to the contract that is used for
creating, changing and deleting semi-static information.

You can select the method at the Method name field.

Transaction

Adds a business object to the contract that is used to change
transactions that occur against the items created using the
Setup class.

You can select the method at the Method name field.

Business Object name Select the business object you want to use for this contract.

Business Object to invoke This displays the description of the business object invoked for
this contract.

This depends on the business object selected and can't be
edited.
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Field Description

Method name Select the method you want to use when invoking the business
object.

The following methods are only available for Setup and
Transaction business object classes:

Add

This adds information to the relevant tables using the
selected business object.

Update

This updates existing information on the relevant tables using
the selected business object.

Delete

This deletes information from the relevant tables using the
selected business object.

You can't select the method for the Build and
Query business object classes, as these are
configured to build or query something by
default and can't be changed.

Operator to log in as
details

Operator code Enter the code of the SYSPRO operator to use when the contract
is run. This can be any operator (with or without specific
securities applied) and doesn't need to be the same operator
code used by the DFM services.

The operator code entered here is displayed against the
transaction in the XML Document Query program.

Disable this contract

Disable contract This disables the contract (i.e. the files and folders are no longer
monitored).

Polling folder
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Field Description

Folder to poll Indicate the folder that must be monitored and require polling.

A valid folder or file must be entered before you can continue.

The folder can reside on the SYSPRO application server or a
different server.

The SYSPRO 8 Document Flow Manager
Folder Poller service must have permission
to read and delete the file in the specified
folder.

File type Indicate the type of file that must be polled for this contract.

Please enter the XML
parameters for Business
Object

This lets you enter XML parameters that indicate how the
document should be processed.

The XML parameters are applied to each document that arrives
in the queue.

Load File

Select Load File to load a sample file with XML parameters.

View Schema

Select View Schema to display the scheme document (SDK)
which specifies the parameters that can be used.

This screen is only displayed for Setup and
Transaction business object classes.

Notify operator when
transaction occurs

Inbox message required Enable this option to specify that a message should be sent to an
operator's Inbox within SYSPRO.

Operator to notify Indicate the code of the SYSPRO operator to whom you want to
send the message.

Program to call Optionally enter the program to run when the operator opens
the message.

Inbox message Enter the message you want to send to the operator.
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Field Description

Set up response Email
messages

Send response Email Enable this option to indicate that a response email message
should be sent to an operator's inbox, notifying them of the
status of the process.

None

No response email message is sent.

Failed

A response email message is sent for every failed contract.

Success

A response email message is sent for every successfully
completed contract.

Both

A response email message is sent for both completed and
failed contracts.

Add success message Select Configure to enter the message you want to send to the
operator, indicating that the process completed successfully.

Add fail message Select Configure to enter the message you want to send to the
operator, indicating that the process failed.

Keep history of XML doc-
uments
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Field Description

XML history required This lets you specify which historical XML documents must be
retained.

You can specify the location of historic XML documents in the
XML Document Control program.

None

No historical XML documents are retained.

Incoming

All incoming XML documents are retained.

Outgoing

Only outgoing XML documents are retained.

Both

Both incoming and outgoing XML documents are retained.

Save Business Object
output XML

Save documents This lets you indicate whether the results from the business
object should be written out to a folder where it can be accessed
by another application such as Microsoft's BizTalk server.

The name allocated to the output file depends on whether you
are retaining history.

If you are retaining history, the file name is constructed of the
company id followed by DO (i.e. Document Out) and then the
next number to use. The suffix is .XML unless you are
performing an XSLT transformation on the file.

Outgoing folder Enter the folder to which the document must be saved.

Transform XML doc-
uments

This section applies to documents that aren't in the format
required by the business object and need to be transformed
using XSLT. Incoming and/or outgoing files can be transformed.
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Field Description

XSL transform required Enable this option to indicate that the XML documents must be
transformed.

None

No file transformation is required.

Incoming

All incoming files must be transformed.

Outgoing

All outgoing files must be transformed.

Both

Both incoming and outgoing files must be transformed.

Incoming XSL filename Select this to perform the transformation of the incoming doc-
ument before it's processed by the business object.

Outgoing XSL filename Select this to perform the transformation of the outgoing doc-
ument (i.e. the result from the business object).

Outgoing file extension This lets you indicate the extension of the outgoing XSL file.

Test XSL transform Select Test XSL transform to test the transform process against
the XSL.

Folder poller service

Service name As more than one poller can be installed, this lets you indicate
the specific poller service that monitors the folder.

Server name This is the name of the server where the folder is located (i.e. the
folder can reside on the SYSPRO application server or a different
server).

Contract type This lets you select the order in which the contracts are pro-
cessed.
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Field Description

Queue type Dependent

This polls files in chronological order (i.e. the previous
contract must be successfully processed before the next one
is started).

The dependent queue information is
saved in the DfmQueueDetail and
DfmQueueDep table using the same
QueueID in both tables.

Non-dependent

This polls files in any order (i.e. the next contract is started
even if the previous one has failed).

The non-dependent queue information is
saved in the DfmQueueDetail and
DfmQueueNonDep table using the same
QueueID in both tables.
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Setup Success Email Message
This is displayed when you select the Configure from the Set up response email messages
section in the Add New Contract Wizard.

Field Description

Email priority Indicate the priority rating for the email message.

Address from Enter the email address of the sender.

Address to Enter the email address of the recipient.

Multiple email addresses can be entered if separated by a semi-
colon (;) as a delimiter.

Subject Enter an appropriate subject line for the email message.

Body Ceate an appropriate message for the email.

A document resulting from the business object will be attached
to the email.
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DFM Queue Query
Exploring

Where it fits in?
This program lets you view and edit the documents that were retrieved by the SYSPRO 8
Document Flow Manager Folder Poller service and placed in the queue.

Things you can do in this program include:

View queue contents.

View failed XML documents and determine the cause.

Edit the input XML, if this caused the failure.

Navigation
This program is accessed from the Program List pane of the SYSPRO menu:

Program List > Administration > Document Flow Manager
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Starting
Security

Activities
You can restrict operator access to activities within a program. These are configured
using the Operator Maintenance program.

Fields
You can restrict operator access to the fields within a program. These are configured
this using the Operator Maintenance program.

eSignatures
You can restrict access to the eSignature transactions within a program at Operator,
Group, Role or Company level. You configure these using the eSignature Setup
program. Electronic Signatures provide security access, transaction logging and event
triggering that gives you greater control over your system changes.

Groups
You can restrict operator access to programs by assigning them to groups and applying
access control against the group. This is configured using the Operator Groups
program.

Passwords
You can restrict operator access to functions within a program using passwords.
Passwords are defined in the Password Definition program. When defined, the
password must be entered before you can access the function.
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Referencing
Menu and Toolbar
Field Description

File

Exit This exits the program.

Options

Show all records Select this to view all records.

Record limit This lets you limit the number of records you see in the list.

The record limit is set to 1000 by default.

Functions

Purge Select this to purge the records displayed in the DFM Queue
Messages pane.

Time filter This lets you select a time reference to filter the list of queue
messages.

Edit Input XML This lets you edit the input XML of the selected file, typically if
the transformation of the document fails.

Edit Parameter XML This lets you edit the parameter XML of the selected file, typically
if the transformation of the document fails.
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DFM Queue Messages
Field Description

Date This indicates the date the file was placed in the queue.

Status This indicates the status code and current position of the
document in the queue.

Contract name This indicates the name of the DFM contract that was specified
when the contract was created.

Company This indicates the SYSPRO company for which this document was
polled and transformed.

Body length This indicates the length of the body of the file in the queue.

Input XML path This indicates the path of the input XML.

Workflow path This indicates the workflow the DFM business object takes when
processing a transaction.

There are various status codes listed against each transaction
that indicate the workflow path of each document in the queue.
The last code in the list matches the code in the Status field.
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XML Document Query
Exploring

Where it fits in?
This program lets you view details of XML documents that are being retained on file. You
configure the history settings and the retention period of these documents using the XML
Document Control program.

Transactions you can view in this program include documents processed by the Document
Flow Manager as well as those created using the Electronic Data Interchange or Business-to-
Business Trading systems.

Things you can do in this program include:

View details of incoming and outgoing XML documents.

View the transformation and processing details.

View details of failed XML documents.

Navigation
This program is accessed from the Program List pane of the SYSPRO menu:

Program List > Business-to-Business Trading
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Starting
Security

Activities
You can restrict operator access to activities within a program. These are configured
using the Operator Maintenance program.

Fields
You can restrict operator access to the fields within a program. These are configured
this using the Operator Maintenance program.

eSignatures
You can restrict access to the eSignature transactions within a program at Operator,
Group, Role or Company level. You configure these using the eSignature Setup
program. Electronic Signatures provide security access, transaction logging and event
triggering that gives you greater control over your system changes.

Groups
You can restrict operator access to programs by assigning them to groups and applying
access control against the group. This is configured using the Operator Groups
program.

Passwords
You can restrict operator access to functions within a program using passwords.
Passwords are defined in the Password Definition program. When defined, the
password must be entered before you can access the function.
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Using
Hints and Tips

You can set a limit to the number of records displayed in the Log Details pane by making
an entry at the Record limit field of the Options menu.

If the number of records reaches this threshold value an information message is
displayed and you can choose to ignore the limit, or only display the number of records
up to this limit.

Columns in a list view are sometimes hidden by default. You can reinstate them using the
Field Chooser option from the context-sensitive menu (displayed by right-clicking a
header column header in the list view). Select and drag the required column onto the list
view.

Fields on a pane are sometimes hidden by default. You can reinstate them using the
Field Selector option from the context-sensitive menu (displayed by right-clicking any
field in the pane). Select and drag the required fields onto the pane.

Press CTRL+F1 within a list view or form to view a complete list of functions available.
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Referencing
Menu and Toolbar
Field Description

File

Exit This exits the program.

Options

Show all records Select this to view all records.

Record limit This lets you limit the number of records you see in the list.

The record limit is set to 1000 by default.

Functions

Purge This lets you purge the records displayed in the Log Details
pane.

Time filter This lets you select the time frame for filtering the data records
displayed in the Log Details pane.

Refresh view This lets you refresh the list of contracts in the Log Details pane.

Show Custom Filter This displays the Filter Options pane, from which you can indic-
ate filtering options.

Log Details
Column Description

Reference This indicates the document reference number.

In/Out This indicates whether the processed document was an
incoming or outgoing document.

Document date-time This indicates the date and time the document was processed.

Operator name This indicates the operator name who processed the document.

Document name This indicates the document name.

Document type This indicates the type of document that was processed (i.e.
history or failed).
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Column Description

History document This lets you view a copy of the original incoming or outgoing
XML document, if you selected this at the XML history required
field when creating the contract using the DFM Setup program.

Filter Options
Field Description

Apply Custom Filter This applies the your selected filter criteria against the archived
records in the Log Details pane.

Reset This resets the form to its default selections.

Date selection This lets you indicate a range of dates according to which you
want to view documents.This indicates the time filter selected
from the toolbar. If you select Range or Single at the Date
selection type field then you can enter start and end date
according to which you want to display information.

Date selection type This lets you indicate the type of date selection you want to use.

Contract selection This lets you select the type of contract you want to include (e.g.
Query, Setup, Posting, Build, B2B, Other).

Operator selection This lets you indicate the operator(s) for whom you want to
select documents.

If you created an __DFM operator code, then
you can enter it here to only display the
documents related to Document Flow
Manager.

Document type This lets you view history or failed documents in the Log Details
pane.

If you enabled the Keep copy of XML
documents and Keep history of
incoming document options (XML
Document Control) then you can view
a copy of the original incoming XML
document.
Documents with a name that ends with
's.xml indicate failed.
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DFM Service Setup
Exploring

Where it fits in?
This program lets you view the status of the DFM services and change configuration values
without having to access the configuration files.

Any configuration changes made using the DFM Service Setup program
only takes effect when next the service polls for a change in configuration
information.

All changes are saved to and read from the database. If no information is
found on the database, the DFM Service Setup program reads the
configuration file.

Things you can do in this program include:

Pause the services.

Specify that logging is required.

Change the polling interval that defaults to 30 seconds.

Change the time interval to determine if there is a change to the configuration.

Navigation
This program is accessed from the Program List pane of the SYSPRO menu:

Program List > Administration > Document Flow Manager
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Starting
Security

Activities
You can restrict operator access to activities within a program. These are configured
using the Operator Maintenance program.

Fields
You can restrict operator access to the fields within a program. These are configured
this using the Operator Maintenance program.

eSignatures
You can restrict access to the eSignature transactions within a program at Operator,
Group, Role or Company level. You configure these using the eSignature Setup
program. Electronic Signatures provide security access, transaction logging and event
triggering that gives you greater control over your system changes.

Groups
You can restrict operator access to programs by assigning them to groups and applying
access control against the group. This is configured using the Operator Groups
program.

Passwords
You can restrict operator access to functions within a program using passwords.
Passwords are defined in the Password Definition program. When defined, the
password must be entered before you can access the function.

Restrictions and Limits
The following flags can't be maintained in this program, but can be edited in the
SYSPRODFMQueuePoller.exe.config and SYSPRODFMFolderPoller.exe.config con-
figuration files.

zeroFileSizeDeleteTime

ConfigPollType (defaults to ss - seconds)

FolderPollType (defaults to ss - seconds)
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PollType (defaults to ss - seconds)

This will be addressed in a future release
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Solving
FAQs

DFM Services
Where can I set the polling type for DFM services?
Although the following flags can't be maintained in the DFM Service Setup program, you
can edit them in the SYSPRODFMQueuePoller.exe.config and
SYSPRODFMFolderPoller.exe.config configuration files:

ZeroFileSizeDeleteTime

ConfigPollType (defaults to ss - seconds)

FolderPollType (defaults to ss - seconds)

PollType (defaults to ss - seconds)

This will be addressed in a future release.

Why don't the DFM Services start?
The password held against the operator used to start the services may have changed.
This could occur automatically by the operating system, depending on the password
policy setup.

Solution

Review the password settings defined against the operator who is starting the
services.

Review the message logs within the Event Viewer.

Why don't the DFM Services start on installation?
This is most likely due to an invalid operator/password combination or the operator
doesn't have sufficient permission to access the folder contents.

Solution
Review the message logs within the Event Viewer.

Where do I define the 'file size delete time' for the DFM folder
poller service?
Although you can't currently maintain the FileSizeDeleteTime in the DFM Service
Setup program, you can edit this in the following configuration files:
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SYSPRODFMQueuePoller.exe.config

SYSPRODFMFolderPoller.exe.config

Configuration
Why are the changes I made not implemented immediately?
Any configuration changes made using the DFM Service Setup program only takes effect
when next the service polls for a change in configuration information.

This interval can be specified at the Config Interval column of the DFM Service Setup
program.

Problem Solving
Where can I find the DFM event log?
The event log is created when DFM is installed. The log is output to the following folder,
which you can review for diagnosing any problems you may encounter:

Control Panel > System and Security Administrative Tools > Event Viewer > Applications and
Service Logs

You can open each entry in the log to view the error or warning details.

The event log is only available if you have selected Yes at the Log required option in the
list view of the DFM Service Setup program.

Why do documents remain in the polling folder?
Likely causes are that the document is not being picked up at all, or is being picked up
but the Document Flow Manager user doesn't have permission to delete the original
document from the folder.

If the document is not being processed, then there are a number of possible causes:

The contract is configured to poll a different folder.

Check the relative pathing from which the service is run.

If the folder is on a remote workstation, ensure that the machine is running and
that the SYSPRO application server can see both the machine and the
share/mapped drive.

The file does not match the file type defined against the contract.

The contract is disabled.

The SYSPRO 8 Document Flow Manager Folder Poller service doesn't have
permission to access the folder.

The file is defined as read-only.
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Review the attributes against the file.

The SYSPRO 8 Document Flow Manager Folder Poller service is not running.

Why are there no results for documents in the polling folder?
The SYSPRO 8 Document Flow Manager Queue Poller service is not running, or the
contract is not configured to output the results from the business object.

Solution

Review the contract to ensure that it is configured to output the results from the
business object and that the correct folder is specified.

Check that the operating system user who is starting the SYSPRO 8 e.net
Communications Load Balancer service has been granted write-access to the
folder.

Check that the user for the SYSPRO 8 e.net Communications Load Balancer
service has been granted write-access to the Failed folder.
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Using
Hints and Tips

Any configuration changes made using the DFM Service Setup program only takes
effect when next the service polls for a change in configuration information.

This interval can be specified at the Config Interval column of the DFM Service
Setup program.

Columns in a list view are sometimes hidden by default. You can reinstate them using
the Field Chooser option from the context-sensitive menu (displayed by right-clicking
a header column header in the list view). Select and drag the required column onto
the list view.

Press CTRL+F1 within a list view or form to view a complete list of functions available.
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Referencing
Toolbar and Menu
Field Description

File

Save This saves the details you entered or changed.

Save and Close This saves the details you entered or changed and returns to the
previous screen.

Exit This exits the program.

Refresh This refreshes the information for the pane.

DFM Services
Field Description

Server name This indicates the DFM service you are maintaining.

Server type F indicates the folder poller and Q indicates the queue poller.

Service instance This is an internal flag.

Service description This indicates a description of the service for identification
purposes.

Status This indicates the current status of the service (e.g. paused,
running, etc).

Paused flag This indicates whether the service is currently paused.

You can select to pause or start the service.

Yes = paused

No = not paused

Log required This indicates whether an event log is required for the service.

You can select whether an event log is required for the service.

Yes = log is required

No = log is not required
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Field Description

Poller interval This indicates how often the service will poll for new files in
configured contract folders and is measured in the unit of time
specified at the PollType flag.

This defaults to 30 seconds, but can be changed here.

Config interval This indicates how often (in seconds) the service must will poll
for changes made to the configuration information.

If the service can't reach the SYSPRO 8 e.net Communications
Load Balancer or business object, it will retry once this interval
has lapsed.

Started date This indicates the date the service was last started.

Updated date This indicates the last time the configuration of the service was
changed.
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DFM Folder Poller service
Exploring

Where it fits in?
This service monitors specified folders and uses the contract details to determine if the files in
the folders should be sent to the DFM queue.

This service is used by:

Document Flow Manager

Navigation
The default location for this service is:

Program Files > SYSPRO > Document Flow Manager Folder Poller
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Starting
Prerequisites

Microsoft .NET Framework 4.6

SQL Server

SYSPRO 8 e.net Communications Load Balancer

The Document Flow Manager folders that are configured against DFM contracts must
be accessible to this service.

This service is installed using the SYSPRO Installer.

The service can be installed multiple times, as determined by the workload.

Restrictions and Limits
If you require files to be processed in a certain sequence then you need to add them
to the queue in the correct order.

The Document Flow Manager processes files as they appear and as the data is
available.

Processing speed may be affected by the number of contracts and folders in use.
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Solving
Debugging and Diagnostics

Service Config.exe file
You can debug this service by editing the associated config file in elevated mode (i.e. with
administrator privileges).

The SYSPRODFMFolderPoller.exe.config file is located in the folder to which you installed
the service.

Windows Event Viewer function
You can view monitoring and troubleshooting messages about this service using the Event
Viewer function in Windows:

(Control Panel > System and Security Administrative Tools > Event Viewer > Applications and
Service Logs)

This service outputs an event log to the SYSPRODocumentFlowManager file.

Windows Services function
You can start, stop, restart and configure this service using the Services function in
Windows:

(Control Panel > System and Security Administrative Tools > Services)
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Referencing
Configuration file

You should only edit this file for debugging purposes.

Don't use this as a method to update values for the service. This is because
a wizard installation updates the system registry, which is what is read
when using the service. A fresh installation overwrites these values, which
may cause problems when you next run the service.

Any configuration changes made using the DFM Service Setup program
only takes effect when next the service polls for a change in configuration
information.

The following settings can be maintained using the DFM Service Setup
program within SYSPRO:

Configuration polling interval

Polling interval

Pause polling

Key Description

WCFAddress This indicates the URL for the SYSPRO 8 e.net Communications
Load Balancer service.

InstanceKey This indicates the base dir instance on the SYSPRO application
server.

languageCode This indicates the SYSPRO language code.

ConfigPollInterval This indicates how often the service will poll for changes made
to the configuration information.

If the service can't reach the SYSPRO 8 e.net Communications
Load Balancer or business object, it will retry once this interval
has lapsed.

This is measured in the unit of time specified at the
ConfigPollType flag.
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Key Description

ConfigPollType This lets you indicate the unit of time (i.e. ss - seconds, mm -
minutes and hh - hours) the service will use to poll for changes in
the configuration information.

You can't use the DFM Service Setup
program to maintain this flag.

FolderPollInterval This indicates how often the service will poll for new files in
configured contract folders.

This is measured in the unit of time specified at the
FolderPollType flag.

This defaults to 30 seconds.

FolderPollType This lets you specify the unit of time (i.e. ss - seconds, mm -
minutes and hh - hours) the service will use to poll for new files
in configured contract folders.

This can only be changed in the configuration
file and defaults to seconds in the DFM
Service Setup program.

zeroFileSizeDeleteTime Specifies the length of time (in seconds) that a zero sized file will
remain in a polling folder, before it is deleted.

This can only be set in the configuration file
and not in the DFM Service Setup program.

DebugService This enables service debug logging.

This outputs the debug messages to the active trace log, which
can be viewed using an application like DbgView.

Although debug messages are not written to file anywhere,
exception messages are shown in the debug stream, as well as
in the event log.

We recommend you set this to true before
starting the service.
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Key Description

PausePolling This enables or pauses folder polling.

Before starting the service you can set this to
false to start the service but pause folder
polling.
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DFM Queue Poller service
Exploring

Where it fits in?
This service monitors and processes files in the DFM queue.

This service is used by:

Document Flow Manager

Navigation
The default location for this service is:

Program Files > SYSPRO > Document Flow Manager Queue Poller
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Starting
Prerequisites

Microsoft .NET Framework 4.6

SQL Server

SYSPRO 8 e.net Communications Load Balancer

The Document Flow Manager folders that are configured against DFM contracts must
be accessible to this service.

This service is installed using the SYSPRO Installer.

This service can be installed multiple times, as determined by the work load.

Restrictions and Limits
If you require files to be processed in a certain sequence then you need to add them
to the queue in the correct order.

The Document Flow Manager processes files as they appear and as the data is
available.

Processing speed may be affected by the number of contracts and folders in use.
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Solving
Debugging and Diagnostics

Service Config.exe file
You can debug this service by editing the associated config file in elevated mode (i.e. with
administrator privileges).

The SYSPRODFMQueuePoller.exe.config file is located in the folder to which you installed
the service.

Windows Event Viewer function
You can view monitoring and troubleshooting messages about this service using the Event
Viewer function in Windows:

(Control Panel > System and Security Administrative Tools > Event Viewer > Applications and
Service Logs)

This service outputs an event log to the SYSPRODocumentFlowManager file.

Windows Services function
You can start, stop, restart and configure this service using the Services function in
Windows:

(Control Panel > System and Security Administrative Tools > Services)
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Referencing
Configuration file

You should only edit this file for debugging purposes.

Don't use this as a method to update values for the service. This is because
a wizard installation updates the system registry, which is what is read
when using the service. A fresh installation overwrites these values, which
may cause problems when you next run the service.

Any configuration changes made using the DFM Service Setup program
only takes effect when next the service polls for a change in configuration
information.

The following settings can be maintained using the DFM Service Setup
program within SYSPRO:

Configuration polling interval

Polling interval

Pause polling

Key Description

WCFAddress Specifies the URL for the SYSPRO 8 e.net Communications
Load Balancer service.

InstanceKey Specifies the base dir instance on the SYSPRO application server.

languageCode Specifies the SYSPRO language code.

ConfigPollInterval This specifies how often the service will poll for changes made to
the configuration information.

If the service can't reach the SYSPRO 8 e.net Communications
Load Balancer or business object, it will try again once this
interval has lapsed.

This is measured in the unit of time specified at the
ConfigPollType flag.
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Key Description

ConfigPollType This lets you indicate the unit of time (i.e. ss - seconds, mm -
minutes and hh - hours) the service will use to poll for changes in
the configuration information.

You can't use the DFM Service Setup
program to maintain this flag.

PollInterval This indicates how often the service will poll for new files in
configured contract folders.

This is measured in the unit of time specified at the PollType

flag.

This defaults to 30 seconds.

PollType This lets you specify the unit of time (i.e. ss - seconds, mm -
minutes and hh - hours) the service will use to poll for new files
in configured contract folders.

DebugService This enables service debug logging.

We recommend you set this to true before
starting the service.

PausePolling This enables or pauses folder polling.

Before starting the service you can set this to
false to start the service but pause folder
polling.
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